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Olvasasi id6: 20 perc
Sisak Istvan Végrehaijtasi id6: 60-90 perc

Feladat 6: Pontadatok térbeli interpolacidja (raszteres talajtulajdonsag
térképek készitése)

Szikséges programok: Saga

Sziikséges adatok: a magunk altal készitett shp pont allomany + készen kapott
shp poligon allomany

Elinditjuk a Saga programot és egy Uj (empty = Ures) projektet kezdiink. Ha volt kordbban elmentett
projektiink, akkor annak a neve az Uj projekt alatt megjelenik. Az ezt kbvet6 tandcsado ablakot

bezarjuk.
&
L HR&EO % 7
Wanager | Properties: Data x
% Tools % Data @) Maps I settings @ Description
[ Tree B3 Thumbnails No parameters available

& Data

() <noitems>

Select Startup Project X
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emp
Ci\zvizsga20200619\saga2020100%tapanyag.sprj
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[E] File System & ODBC i PostgresL

- WINTO (C) Cancel

- WIN10-REGI (D:)
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Az ires projektben felll van harom meni-fil (File, Geoprocessing, Window). A Window meniiben
lehet pl. a képernyén lathaté ablakokat ki- és bekapcsolni. Néhany ikon is Iathaté egyes funkcidk
gyors eléréséhez, de azok a meniibdl is hivhatdk. A képernyd bal felsé részében van a Manager ablak,
benne harom fil: Tools, Data, Maps. A fllek koz6tt valtogatva az alatta l1évé ablakban vagy elemzé
eszkozok strukturalt listaja (Tools), vagy a behivott és az elemzések soran létrehozott adatok listaja
(Data), vagy az adatokbdl egy kiilon utasitassal Iétrehozott térképek listaja (Maps) latszik. Ha vannak
térképek, akkor azok a képernyé jobb oldalan lathato legnagyobb mez6ben jelennek meg. EgyelGre
adatunk és térképlink nincs. A képerny6 bal alsé részében a konyvtarstruktura jelenik meg. A




képernys kdzépsd részsén van a Properties ablak. Ebben a Manager ablakban kivalasztott barmilyen
elemrdl jelennek meg tulajdonsagok.

5 SAGA

File Geoprocessing Window 1
- L1 Eo @)

S Data
L0 <noitems> Show Logo at Start Up
Process Update Frequen 0
Save Configuration [
Number of CPU Cores | 8
Beep when finished  []
Tool Description Source built-in
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= WINID(C)
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Toltstik be a QGIS programmal létrehozott WGS 84 vetiiletl
programba a File>Shapes>Load.

vektoros (pont) shape allomanyunkat a

& saca - a *
File Geoprocessing Window 7
Open AR d
) % | Properties: Tool Libraries x
Project > N
Settings [
Table > _. wcal ()
e L Civizsgal23_2021_01_25_2T\talajpontok2.shp
™ % Cilvizsgal23_2021_01_25_2T\talajpontok:shp
e L Ci\vizsga123_2021_01_25_2T\WGS._tablakeret3.shp
sl Civizsgal23_2021_01_25_2N\Export_tabla_keret.shp
Exit Cizvizsga_2021_01_19_prectipag 9 vizsga202101 OV.shp
CAzvizsga_2021_01_19_prectipag OFd\adatok vizsga20210119\Export tabla_keret.shp
CA\zvizsga20200619\Extract,_ddm_11 [Interval 1-000000].shp
Ci\zvizsga_2021_01_19_prectapag _9f5\adatok_vizsga20210119\termes.shp
Ch\avizsga_2021.01.19, vi 119\termes_FeatureToPoint.shp
Ci\zvizsga_2021_01_19_prectapag_9fG\adatok_vizsga20210119\Export_ddm_kerethp.shp
'g ‘:"“" Ci\zvizsga20200619\talajadatok20201003_EQV.shp
% CAADATOK\Siofok_termeskRIGELT.shp
= WINID(C) ) .
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CAADATOK!Siofok talaj.shp
DADigitalis talaj gyakorlat\adstok gyskorlathoz\Siofok talajshp
" \Digitl Soil Mappinghadatok gy Siofok. alashp
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Ha megtettiik, a Manager ablakban a Data fllnél maris lathato a fajl neve és az ikonok mutatjak, hogy
pont adatokrdél van szd, a bal alsé ablakban (Data Sources) latszik, honnan hivtuk be, és a kozépsé
(Properties) ablakban 6t ful alatt az |atszanak a tulajdonsagai, példaul a Description filben latszik,
hogy WGS 84 vetiletd allomanyrdél van szo.
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[Wanager X | Properties: 01. talajpontol2 x
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%% 01. talajpontok2 Name talajpontok2
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File C-Wwizsga123_2021_01_25_27\alajpo,

Modified no

Proj ic Ci System:
GCS_WGS_1984
[+proj=longlat +2=6378137.000000 |
+b=6356752 314245 +no_defs]

- West 18.05668

Data Sources x
] File System & ODBC  # PostgresQ East 18.06474

@ GPS.es talsjcsv ~ ||| WestEast 0.0080600000000004
a' GPS_es_talajxisx South 46.85089

SO g Ve f North 46.86196

2 HUM_krig_TIF legend.tif

o= “_,D;:?,‘F.ﬁ, South-North 0.011070000000003688
2 KA_IDW_TIF_legend.tif Type Point

= MESZ_kiig_TIF tif Vaitei XY

2 MESZ_krig_TIF legend.tif Type

5] talajpontok.dbf

[} talajpontok.shp g';‘:“’ e

[&] talajpontok2.dbf

[-‘_-" “‘wj L ok2.shp Selected 0

A Manager-Data ablakban jobb egérgombbal rakattintunk a pont allomany nevére, erre megjelenik
egy meniablak, rakattintunk az Add to Map utasitasra.
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sl D096 v ¢
[Manager
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= Shapes
- Point )
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Clese File C:wizsga123_2021_01_25_2T\talajpo
[ AddeMee L Modified o
Save Projecti Geographic C: System:
GCS_WGS_1984
Savess. [+proj=longiat +a=6378137 000000
Delete Associated Files +b=6356752 314245 +no_defs]
— Spatial West 18.05668
] FleSystem g ODE  Histogram Eont 18.06474
[T o oPs.etoljcs T West-East  0.0080600000000004
4’ GPS_es_talajx| : South 46.85089
& HUMLJsig T Copy Settings from other Layer North 16 a0156
2 HUM_krig_TIF Attributes 4
= a0 Trsi Edit , | South-North 0.011070000000003688
= KAIDW_TIF le, Type Point
2 MESZ_kiig_TIF.tif Vertex Xy
# MESZ_krig_TIF_Jegend.tf Type '
la)| k.
falejpontok.dbf Number of 48
] talajpontok.shp Shapes
talajpontok2.dbf
| D mjm P v e ¢
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Erre a jobb oldali mez&ben létrejon az adatokbdl egy térkép. Ha nem tolti ki az ablakot, a peremeinél
fogva nagyobbra igazithatjuk. Az adatokat, amit a térképen abrazolunk, most mar mutatja a
Manager-Maps ablak, és ha a kozépsé (Properties) ablakban a Legend (jelmagyarazat) fulet
valasztjuk, ott az is lathatd, hogy piros szind, fekete peremdi jelekkel (ebben az esetben kérokkel)
abrazoljuk az adatokat a térképen. A térképek peremén a koordindta rendszeriink beosztasa lathatd,



ebben az esetben a fokbeosztas. Az én térképemen van egy méréléc is, de az kikapcsolhato egy felsé

sorban 1évé ikonnal.
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FHEE%0 v T
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B wistory B Legefd [ Attributes
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|
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GPS_es_talaj.xlsx

% HUM _krig_TIF.tif

# HUM_krig_TIF _legend tif
KA_IDW_TIF if
KA_IDW_TIF_legend.tif
MESZ_krig_TIF if
MESZ_krig_TIF_legend.tif
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Az ikonok soraban a létrehozott jobb oldali térképpel kapcsolatos gyors beallitdsi gombok vannak.
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2Zoom to Active Layer
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Bl X O&Ma

3p @ | — J

Print Scale North

Layout Bar  Arrow

Ezek koziil az elsé kett6 nagyon hasznos, mert gyakran el6fordul, hogy a jobb oldalon, ahol a
térképiink valéban latszik, kinavigalunk a lathatd adatok tartomanyabdl, és nem taldlunk vissza.
Akkor az elsé ikonnal a teljes térképre tudunk navigalni, a masodikkal pedig abban az esetben, ha
mar tébb adatot is abrazoltunk ugyanazon a térképen, a Manager-Maps ablakban aktiv (kivalasztott)
rétegre allitjuk a térképi nézetet egyetlen kattintdssal. A nyil (Action) a térképen elemek
kivalasztasdra valdé, A Zoom nagyitasra, a Pan pedig a térkép ide-oda mozgatasara. A tobbi elem
inkdbb a megjelenitésben fontos, ha a kész munkabdl térképi bemutatdt akarunk késziteni pl.

el6adéashoz.

Gyakran hasznalt, egyszer( interpolacios mddszer az IDW (Inverse Distance Weighted), amit a
Manager-Tools ablakban a Grid>Gridding>Inverse Distance Weighted utasitassal valasztunk ki. A
Properties Ablakban a Settings flilben lathatd, hogy ki kell valasztanunk a pont allomany nevét
(Points melletti kis ablakban) és azt a tulajdonsagot (Attribute), amire nézve az interpolaciot
elvégezzik (CaCO3). A tobbi beallitast hagyjuk Ugy, ahogy a program automatikusan beallitja. A
Cellsize az automatikus bedllitasban 0,00039 fok, ami kb. 40-50 méter terepi pixelméretet jelent. Ha
a kozéps6 (Properties) ablak alatt Iathaté gombok kozil rakattintunk a kozépsé (Execute) gombra,



akkor a program végrehatja a kijelolt adatokkal az altalunk meghatarozott médon az IDW

interpolaciot.
& sAGA
File Geoprocessing Map Window

THEDOSe| % P coS LB RO |~
Manager X || Properties: Inverse Distance Weighted x
" Tools & Data @ Maps I settings @ Description
=@ Grid || © Data Objects -
o @ Analysis = Shapes
+ @ Calculus 1 > Points m_my
1@ Calculus BSL m €ac03 o
- @ Filter o
@ Filter (Perego 2009) el
=@ Gridding Cross Validation none
4 Angulsr Distance Weighted = Target Grid System user dzﬁV
#g Grid Cell Area Covered by M Cellsize 0.00039
®g Inverse Distance Weighted Left 18.0551
® Kernel Density Estimation Right 18.066
% Modifed Quadratic Shepard Bottom 16,3491
% Natural Neighbour . Top 263636
Bt Mlnocacs Mloinkbaie
Columns 29
Osta Sources x R %
File Evyﬂ:prsl #g ODBC #& PostgreSQL i o
0.] GPS.es talgj.csv - £ Search Options
A1 GPS_es talajxlsx Search Range global
2 HUM_krig_TIF.tif - - - -
& HUM kg T legend.tf  Number of Points all points within search dist
& KAIDW_TIFtif B Distance Weighting
& KAIDW_TIF_legend.tif Weighting Function | inverse distance to a power
& MESZ_krig_TIF.tif Iensarra Dirtance Wainht 2
2 MESZ_krig_TIF _legend.tif Attribute
[] talajpontolc.dbf Table field
7] talajpontok.shp
=] talajpontok2.dbf
[_] talajpontok2.shp v 4
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Ezt abbdl 1atjuk, hogy a Manager-Data ablakban megjelenik a elvégzett mivelet eredményeként
|étrejott raszteres adatdllomany.
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Manager X || Properties: 01 talajpontok2 x
% Tools & Data [F Maps B History B Legend [ Attributes
E Tee 89 Thumbnails I settings © Description
& Data (= Options C)

WPy Grids /&‘Gmni
=1 0.00039; 29x 38y; 18.054855¢ 46843045y / Name talajpontok2
B 01. CaCO3 [Inverse Distance Weighted] Description
=-%@ Shapes No Data -99999; 99999
* Point Show Legend =
"% 01, talajpontok2 & Display
Transparency [%] 0
Show at all scales ]
Chart 26 parameters
Fill Style Opaque
=] Outline M
Data Sources X Color W sk
File System g ODBC g PostgreSQL Sae 3
Q. GPS_es talajcs < Symbol Type circle
) GPS_es talajxlsx T —
& HUM_kiig_TIF.tif
2 HUM _krig_TIF_legend tif Type Single Symbel
& KAIDW_TIFtif B Single Symbol
& KA_IDW_TIF legend.tif Color M red
& MESZ_krig_TIF-tif e =
& MESZ_krig_TIF _legend.tif
=] talajpontok.dbf
7] talajpontok.shp
=] talajpontok2.dbf
[_] talajpontok2.shp v
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Ezt hozzdadjuk a mar meglévé térképiinkhoz: jObb klikk a raszteres adat nevére a Manager-Data
ablakban, utana Add to Map, de ne az ujat (New) valasszuk, hanem azt, amit mar létrehoztunk. Az (]
réteg eltakarja a pontokat, ezért a Manager-Maps ablakban az egérrel megfogjuk (lenyomott bal egér
gomb) a pontokat, és alulrél folfelé ratoljuk a raszteres dllomany nevére. Ekkor feliilre keriilnek a
pontok, és latszanak a térképen. A k6zépsé (Properties) ablakban a Legend fiilet valasztva latjuk,
hogy a szinskala milyen tényleges mésztartalom értékeket jelent.

& saca - X
File Geoprocessing Map Window ?
s BRRe I T Coss B RNao®M& oml—J
[Manager | [Properties: 01. CaCO3 [nverse Distance Weighted] x
% Tools i Data @) Maps == I settings Description [ 01. talgjpontol
S 054 18 0% 18.0%8 18.000
(=) Tree =3 Thumbnails B History B Legens Attributes P - —
I Maps

= 01. talsjpontok2

%% 01. talajpontok2 /
I 01. CaCO3 [Inverse Distance Weighted]

| Data Sources. x
File System & ODBC & PostgreSQL

GPS_es_talaj.csv A
GPS_es_talajxlsx
HUM_krig_TIF if
HUM_krig_TIF_legend tif
KA_IDW_TIF tif
KA_IDW_TIF_legend.tif
MESZ_krig_TIF if
MESZ_krig_TIF_legend.tif
] talajpontok.dbf
talajpontok.shp
] talajpontok2.dbf
talajpontok2.shp
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J6 lenne Iatni a tablahatarokat, ezért a File>Shapes>Load paranccsal toltsiik be a programba.
Figyelem: ha tobbféle allomanyunk van, akkor a WGS 84 vetiilet(it téltsiik be! A Manager-Data
ablakban adjuk hozza az Uj dllomanyt a mar meglévé térképiinkhoz (jobb klikk). A Manager-Maps
ablakban megjelenik, de egyel6re még mindent eltakar, mert a poligon teriilete ki van toltve egy
szinnel. Valasszuk ki a Manager-Maps ablakban az Uj dllomanyt, és a kozépsé (Properties) ablakban a
Settings fulnél a kdzéptajon éva Fill Style beallitasi lehetGséget allitsuk Transparent (atlatszo) értékre
(bele kell kattintani a jobb oldali téglalapba), és a Size (vastagsag) bedllitasi lehet&séget allitsuk 2-re,
majd alul kattintsunk az Apply (alkalmaz) gombra.

WGS_tablakeret3.shp
] WGS _tablakeretd.dbf
WGS_tablakeretd.shp

] WGS_tablakeret5.dbf
WGS_tablakerets.shp . /
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& sacA - T ®
File Geoprocessing Msp Window ?
A== AR ) %D 2|~
[Manager X | Propertes: 01, WGS_labiakerets x
® Tocls & Data @ Maps = T Bl Legend [E Attributes I e @
[E] Tree B9 Thumbnails o 305 180 o 5084 18 1
B Maps ~ =
= 01. talsjpontok2 =
£ 01, WGS_tablakeret WGS_tablakeret5 =
%% 01. talajpontok2 Description £
B 01. CaCO3 [Inverse Distance Weighted] 5 No Data -99999; -99999 H
Show Legend s
E Display =
Trensparency [%] 0 g
Show at all scales -
Chart 10 pireme‘l:u/ -
Fill Style Transparent =
| = Outline .
Data Sources e 2 2
- - Color M ;- H
=] FileSystem 4§ ODBC #§ PostgresQL e 2 .
talsjpontak.shp ~ Show Vertices ne E
| talajpontok2 dbf
N Show Centroid -
talajpontok2.shp o I°“ entrel ] H
@ talajuizsgalatok.xis: e =
& yHUMUSZkrig tif Type Single Symbol 2
2 WHUMUSZkig_legend.tif 5 Single Symbol 5 g
| WGS_tablakeret3.dbf Color . o =
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A Manager-Tools ablakban a Grid>Spline Interpolation>Cubic Spline Approximation utasitast is
hajtsuk végre a Properties-Settings ablakban bedllitott adatokkal (pontok CaCO3). A beallitas utan

alul nyomjuk meg el6sz6r az Apply gombot és utana az Executre gombot. A Manager
Data ablakban megjelenik az Uj raszter adat, ezt adjuk hozza egy Uj térképhez, és adjuk hozza a
tablahatart is, a kozépsd ablakban jelenitsiik meg a raszter jelmagyarazatat (Properties-Legend). A
madszer ott, ahol nincsenek pontok, egész extrém és valotlan mésztartalmakat becsult (minusz 16 %
és 48 %), de a tablahatarokon beliil. ahol vannak pontok, a valds értékeket mutatd, folyamatos
atmenet( becsilt térképlink keletkezett.

& SAGA - [03. talajp CaCO3 [Cubic Spline imati -

2
|
B %
x

[ File Geoprocessing Msp Window 7
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Wanager  |[Propertes: 03 €aC03 [Cubic Spine Appi

% Tools % Data 1B Maps B settings @ Description =
Tree 83 Thumbnails I Legend B History Attributes
@ Maps talajpontok2.CaCO3 [Cubic Spline Approximation]

= [ 01. talajpontok2
£ 01. WGS_tablakeretS
%% 01. talajpontok2
I 01. C5CO3 [Inverse Distance Weighted] 32
- [ 03 2.CaC03 [Cubic Spline A
£ 01. WGS _tablakeretS
o CaCO3 [Cubic Spline Approximati e
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Data Sources x
FileSystem  #g ODBC 4§ PostgreSQL
talajpontok.shp ~
[ talajpontok2.dbf
] talajpontolk2.shp
d talajvizsgalatokaxlse
& uHUMUSZkrig tif
& GHUMUSZksig_legend tif
[&] WGS_tablakeret3.dbf
(] WGS_tablakeret3.shp
[ WGS _tablakeretd.dbf
WGS_tablakeretd.shp
] WGS_tablakeret5.dbf
| WGS_tablakeret5.shp

0.005

0.005

0,004

Recognized Files vl < >




A Manager-Tools ablakban a Spatial and Geostatistics>Kriging>Ordinary Kriging utasitassal, majd a
k6zépsb ablakban a pontok CaCO3 bedllitas és az Apply és az Execute gombok megnyomadsaval egy
Ujabb raszteres réteget hozunk létre a krigelés mddszerével, ami elméletileg sokkal jobb médszer,
mint az el6z6ek. Egy modellt haszndl a pontok egymastdl valé tavolsaga és a talajtulajdonsag
variancidja 6sszefliggésének a leirdsdra, és megengedi azt, hogy ett6l a modelltél eltérd hiba is legyen
az adatokban. Az Execute gomb megnyomasa utdn erre a modellre vonatkozé ablak jelenik meg. A
diagram vizszintes tengelyén abrazolt ponttavolsag (Distance) és a mi esetiinkben a CaCO3 tartalom
varianciaja (Variance) k6zott a tényleges 6sszefliggést a pontok mutatjak, az erre illesztett elméleti
Osszefliggést pedig a folytonos vonal. A bal oldali lehetGségek koziil valasszuk ki a Preferred
Functions (el6nyben részesitett fliggvények) kdzil a négyzetgyokos fliggvényt (square root), és
kattintsunk a bal felsé sarokban az OK gombra.
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LA = DR SEEC Y- 2R WD I~
Uianager Variogram X
3 Tools % Data
@ Import/Export <
ok g
@ Projection
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A raszteres adllomany létrejott, és latszik a Manager-Data ablakban. Csinaljunk beldle uj térképet,
amihez a tablakeretet is hozzdadjuk, és kozépen beallitjuk a jelmagyarazatot (Legend). Az adatok
tényleges terjedelménél (0-26 %) kisebb a becsiilt térkép terjedelme (kb. 4-14 %).
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A fentiekben leirt mddon készitsik el az IDW maddszerrel az Arany féle kotottségi szam és a krigelés
madszerével a humusztartalom térképét is. A mésztartalom térképek kozil a krigeléssel |étrehozott
térképet tartsuk meg a tovabbi munkahoz.

Mentsiik el a harom eredményiil kapott raszteres dllomanyt. A Manager-Data ablakban jobb
egérgombbal kivalasztjuk a meniibél a Save as Image lehetGséget.
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J6l megjegyezhetd nevet adunk az dllomdanyunknak, és (FONTOS!) .tif formatumban mentjik el.
Ugyanigy elmentjik a kotottségi szdmra és a humusztartalomra vonatkozo raszteres dllomdanyunkat
is. Ezeket a QGIS programmal fogjuk megnyitni és hasznalni.
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Elmentjik a projektlinket, ami egy kis fajl, amiben fel van jegyezve minden informacid, ami a mostani
projektben van (milyen dllomanyokat hasznaltunk, vannak-e térképek és milyen adatokbdl, milyen
megjelenitésben stb.)

Figyelem! Azok az dllomanyok, amit a munka sordn létrehoztunk, de nem mentettiink el,
elvesznek, és nem allithatdk vissza.
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A program rd is kérdez, hogy mit akarunk elmenteni. Ha bekattintjuk a Save all utasitast, akkor

mindent el fog menteni.
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Tovabbi olvasnivald angolul ért6k részére:
https://sagatutorials.wordpress.com/training-manual/



https://sagatutorials.wordpress.com/training-manual/

Ellen6rzé kérdések:

1. Milyen interpolaciés mdédszereket hasznaltunk?
2. Hogyan fligg a talajtani adatok variancidja a mért pontok tavolsagatél?
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